INSTALLATION GUIDE

BNC-2110
BNC Adapter for E/M/S Series and Analog Output Series Devices
This installation guide describes how to install and configure your BNC-2110 accessory with 68-pin or
100-pin E/M/S Series or 68-pin NI 671x/672x/673x Analog Output (AO) Series multifunction data
acquisition (DAQ) devices. This document also contains accessory specifications.
The BNC-2110 is ideal for simplifying connections between your measurement apparatus and your
DAQ device in laboratory, test, and production environments. The BNC-2110 has the following features:
•

15 BNC connectors for analog input, analog output, trigger/counter functions, and user-defined
signals

•

A spring terminal block with 30 pins for digital and timing I/O signal connections

•

A 68-pin I/O connector that connects to multifunction DAQ devices

•

Can be used on a desktop or mounted on a DIN rail
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Conventions
The following conventions are used in this document:
<>

Angle brackets that contain numbers separated by an ellipsis represent a range of values
associated with a bit or signal name—for example, AO <3..0>.

»

The » symbol leads you through nested menu items and dialog box options to a final action.
The sequence File»Page Setup»Options directs you to pull down the File menu, select the
Page Setup item, and select Options from the last dialog box.
This icon denotes a note, which alerts you to important information.
This icon denotes a caution, which advises you of precautions to take to avoid injury, data loss,
or a system crash. When this symbol is marked on a product, refer to the Read Me First: Safety
and Radio-Frequency Interference document for information about precautions to take.

bold

Bold text denotes items that you must select or click in the software, such as menu items and
dialog box options. Bold text also denotes parameter names.

italic

Italic text denotes variables, emphasis, a cross-reference, or an introduction to a key concept.
Italic text also denotes text that is a placeholder for a word or value that you must supply.

monospace

Text in this font denotes text or characters that you should enter from the keyboard, sections
of code, programming examples, and syntax examples. This font is also used for the proper
names of disk drives, paths, directories, programs, subprograms, subroutines, device names,
functions, operations, variables, filenames, and extensions.

Platform

Text in this font denotes a specific platform and indicates that the text following it applies only
to that platform.

What You Need to Get Started
To set up and use your BNC-2110 accessory, you need the following:

❑ BNC-2110 BNC adapter(s)1
❑ BNC-2110 Installation Guide
❑ One of the following DAQ devices:
–

68-pin AO/E/M/S Series device (with one or two I/O connectors)2

–

100-pin E Series device

❑ Cable(s) for DAQ device(s), as listed in Table 1
❑ The Analog Output Series User Manual, the E Series User Manual, the M Series User Manual,
or the S Series User Manual

❑ BNC cables
❑ Small flathead screwdriver
❑ 28–16 AWG wire
❑ Wire strippers

1
2

You can use two BNC-2110 accessories with both connectors of NI 6224/6229/6254/6259/6284/6289 M Series devices.
On two-connector AO Series and NI 6225/6255 devices, you cannot use the device’s second connector with the BNC-2110.
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Installing the BNC-2110
Figure 2 shows the front panel of the BNC-2110.
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Analog Input/Analog Output BNC Connectors
FS/GS Switches
Terminal Block Retaining Screws
Digital and Timing I/O Spring Terminal Blocks
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Power Indicator Light
Trigger/Counter BNC Connectors
User-Defined Signals BNC Connectors

Figure 1. BNC-2110 Front Panel

To connect the BNC-2110 to your DAQ device, complete the following steps. Consult your computer or
PXI/PXI Express chassis user manual for specific instructions and warnings.
Note If you have not already installed your DAQ device, refer to the DAQ Getting Started Guide for
instructions.
Caution Do not connect the BNC-2110 to any device other than National Instruments
AO/E/M/S Series multifunction DAQ devices. Doing so can damage the BNC-2110, the DAQ device,
or the host computer. National Instruments is not liable for damage resulting from these connections.
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1.

Place the BNC-2110 near the host computer or PXI/PXI Express chassis or use the optional DIN
Rail Mounting kit for UMI-FLEX-6 and BNC boxes (part number 777972-01), which you can
order from National Instruments at ni.com.
Caution

Do not connect input voltages greater than 42.4 Vpk/60 VDC to the BNC-2110. The
BNC-2110 is not designed for any input voltages greater than 42.4 Vpk/60 VDC, even if a
user-installed voltage divider reduces the voltage to within the input range of the DAQ device. Input
voltages greater than 42.4 Vpk/60 VDC can damage the BNC-2110, all devices connected to it, and
the host computer. Overvoltage can also cause an electric shock hazard for the operator. National
Instruments is not liable for damage or injury resulting from such misuse.
2.

Connect the BNC-2110 to the DAQ device using the appropriate cable for your DAQ device, as
listed in Table 1.
Table 1. BNC-2110 Cabling Options

Number of Pins
68-pin

100-pin
*
†

DAQ Device

Recommended Cable(s)

NI 6715 AO Series
DAQCard E Series
NI PCI/PCIe/PXI/PXIe M Series*
NI 6143 S Series

SHC68-68-EPM or RC68-68

NI 672x AO Series†

SH68-C68-S

NI 6711/673x AO Series
PCI/PXI E Series
USB Mass Termination M Series*
NI 6110/6111/612x/613x S Series

SH68-68-EP or R6868

NI 6713 AO Series
NI 6115/6120 S Series

SH68-68-EP

PCI/PXI E Series

SH1006868

You cannot connect the BNC-2110 to Connector 1 of NI 6225/6255 devices.
You cannot connect the BNC-2110 to the AO 8–31 Connector of NI 6723 devices.

The power indicator light, shown in Figure 1, lights. If it does not light, check the cable and wiring
connections.
3.

Launch Measurement & Automation Explorer (MAX), confirm that your DAQ device is
recognized, and configure your device settings. Refer to the DAQ Getting Started Guide for more
information.

4.

Connect signals to the BNC connectors and spring terminal block as described in the following
sections.
Note With NI-DAQmx, National Instruments has revised its terminal names so they are easier to
understand and more consistent among NI hardware and software products. The revised terminal
names used in this document are usually similar to the names they replace. For a complete list of
Traditional NI-DAQ (Legacy) terminal names and their NI-DAQmx equivalents, refer to the
Terminal Name Equivalents table in the NI-DAQmx Help.

5.

Test specific device functionality, such as the ability to send and receive data with MAX test panels.
Refer to the DAQ Getting Started Guide for more detailed information about running test panels
in MAX.
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When you have finished using the BNC-2110, power off any external signals connected to the
BNC-2110 before you power off your computer.

Connecting Differential Analog Input Signals (E/M/S Series Devices Only)
Use the BNC-2110 BNC connectors on the front panel to connect AI <0..7> signals to E/M/S Series
DAQ devices. The BNC-2110 is only intended for differential analog input signals. The number of
connectors you use depends on your DAQ device and application. Complete the following steps to
measure a differential (DIFF) analog input signal.
1.

Connect the BNC cable to one of the AI <0..7> BNC connectors on the front panel.1

2.

Configure your software to measure this channel differentially.

3.

Move the FS/GS switch to the applicable position, depending on whether you are measuring a
floating source (FS) or ground-referenced source (GS) analog input signal. Refer to the Measuring
Floating Signals and Measuring Ground-Referenced Signals sections for more information about
these signal sources.

Measuring Floating Signals
To measure floating signal sources, move the corresponding switch below the BNC connector to the FS
position. In the floating source switch position, the DAQ device’s amplifier negative terminal connects
to ground through a 5 kΩ resistor in parallel with a 0.1 μF capacitor, as shown in Figure 2. Refer to your
DAQ device documentation for more information about measuring floating signals.

Signal
Source

BNC-2110

+
–

DAQ Device
(Differential Input Mode)

+
FS
0.1 μF

–
FS Mode
AI GND

5 kΩ

Figure 2. Measuring a Floating Signal Source

Measuring Ground-Referenced Signals
To measure ground-referenced signals, move the switch below the BNC connector for the AI channel
you are using to the GS position. Using the ground-referenced source switch position avoids ground
loops, as shown in Figure 3. Refer to your DAQ device documentation for more information about
measuring ground-referenced signals.

1

When using the BNC-2110 with Connector 1 of NI 6224/6229/6254/6259/6284/6289 devices, the AI <0..7> BNCs on the
BNC-2110 map to the AI <16..23> channels on the M Series device.
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Signal
Source

BNC-2110

+
–

DAQ Device
(Differential Input Mode)

+
GS
0.1 μF GS Mode

–

AI GND

5 kΩ

Figure 3. Measuring a Ground-Referenced Signal Source

Connecting Analog Output Signals
Use the BNC-2110 BNC connectors on the front panel to connect AO <0..7> signals to your DAQ
device. The number of connectors you use depends on your DAQ device and application. E/M/S Series
DAQ devices can only use the AO <0..1> BNCs.1 AO Series DAQ devices can use the AO <0..1> and
the AO <2..7> BNCs. Refer to your DAQ device documentation for information about the use of these
signals.
Note

(AO Series Devices Only) When using connectors AO <2..7>, you must move the associated
FS/GS switch(es) to the FS position.

Connecting APFI 0/AO EXT REF Signals
Use the BNC-2110 BNC connectors on the front panel to connect the analog programmable function
interface channel, APFI 0, to your M Series DAQ device or analog output external reference,
AO EXT REF, to your AO/E/S Series device.2 The AO EXT REF BNC is the external reference input
for the AO circuitry. With some M Series devices, the APFI 0 channel can be used as the external
reference input for the AO circuitry, the external offset for the AO circuitry, or the analog trigger input.
These functions are not available on all devices. Whether you can use this BNC depends on your DAQ
device and application. Refer to your DAQ device documentation for information about the use of these
signals.

1

2

When using the BNC-2110 with Connector 1 of NI 6229/6259/6289 devices, the AO <0..1> BNCs on the BNC-2110 map to
the AO <2..3> channels on the M Series device.
When using the BNC-2110 with Connector 1 of NI 6254/6259/6284/6289 devices, the APFI 0 BNC on the BNC-2110 maps
to the APFI 1 channel on the M Series device.
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Connecting Trigger/Counter Signals
Use the BNC-2110 BNC connectors on the front panel to connect PFI 0/P1.0 (AI START TRIG) and
PFI 12/P2.4 (CTR 0 OUT) signals to your DAQ device. The number of connectors you use depends on
your DAQ device and application. Refer to your DAQ device documentation for information about the
use of these signals. Table 2 describes the trigger/counter BNCs.
Table 2. Trigger/Counter Signal Descriptions

BNC
PFI 0/P1.0

Description
Programmable Function Input channel 0 or Port 1 Digital Input/Output channel 0
AI START TRIG (AI Start Trigger Signal)—As an output, this pin is the ai/StartTrigger
signal. In post-trigger DAQ sequences, a low-to-high transition indicates the initiation of
the acquisition sequence. In applications with pre-trigger samples, a low-to-high transition
indicates the initiation of the pre-trigger samples.

PFI 12/P2.4

Programmable Function Input channel 12 or Port 2 Digital Input/Output channel 4
CTR 0 OUT (Counter 0 Output Signal)—As an input, this pin can be used to route signals
directly to the RTSI bus. As an output, this pin emits the Ctr0InternalOutput signal.

Connecting Digital and Timing I/O Signals
Use the BNC-2110 spring terminal block on the front panel to connect digital and timing I/O signals to
your DAQ device. Refer to your DAQ device documentation for information about the use of these
signals.
When connecting signals to the spring terminals, you can use 28–16 AWG wire with the insulation
stripped to 0.28 in.
Table 3 describes the digital terminals on the front panel of the BNC-2110.
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Table 3. Digital and Timing I/O Terminal Descriptions

Terminal

Description

PFI <1..7>/
P1.<1..7>

Programmable Function Input channels 1 through 7 or Port 1 Digital Input/Output
channels 1 through 7

PFI <8..9>/
P2.<0..1>

Programmable Function Input channels 8 through 9 or Port 2 Digital Input/Output
channels 0 through 1

PFI 10/P2.2

Programmable Function Input channel 10 or Port 2 Digital Input/Output channel 2
EXT STROBE (External Strobe Signal)—You can toggle this output with software
controls to latch signals or trigger events on external devices

PFI 11/P2.3*

Programmable Function Input channel 11 or Port 2 Digital Input/Output channel 3
AI HOLD COMP (AI Hold Complete Event Signal)—When enabled, this signal pulses
once for each A/D conversion in sampling mode. The low-to-high edge indicates when the
input signal can be removed from the input or switched to another signal.

PFI 13/P2.5

Programmable Function Input channel 13 or Port 2 Digital Input/Output channel 5
CTR 1 OUT (Counter 1 Output Signal)—As an input, this pin can be used to route signals
directly to the RTSI bus. As an output, this pin emits the Ctr1InternalOutput signal.

PFI 14/P2.6

Programmable Function Input channel 14 or Port 2 Digital Input/Output channel 6
FREQ OUT (Frequency Output)—This output is from the frequency generator

P0.<0..7>

Port 0 Digital Input/Output channels 0 through 7—You can individually configure each
signal as an input or output. P0.6 and P0.7 can control the up/down signal of
general-purpose Counters 0 and 1, respectively

D GND

Digital Ground—This terminal supplies the reference for the digital signals at the I/O
connector as well as the +5 VDC supply

USER <1..2>

User-Defined 1 and 2—Internally routed to USER 1 or USER 2 BNC, this terminal
provides a user-definable BNC terminal. Refer to the Using the USER 1 and USER 2 BNC
Connectors section for more information about using these signals.

+5 V

+5 V Power Source—These terminals are fused on the DAQ device; the current available
depends on the device to which it is connected. Refer to your DAQ device specifications
for more information.

AI GND*

Analog Input Ground—The analog input voltages are referenced to this node

AI SENSE*,†

Analog Input Sense—This terminal is the reference node for channels AI <0..15> in
non-referenced single-ended (NRSE) configurations

*
†

E/M/S Series devices only.
Single-ended mode is not recommended on the BNC-2110.
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Using the USER 1 and USER 2 BNC Connectors
The USER 1 and USER 2 BNC connectors allow you to use a BNC connector for a digital or timing I/O
signal of your choice. The USER 1 and USER 2 BNC connectors are routed (internal to the BNC-2110)
to the USER 1 and USER 2 spring terminals, as shown in Figure 4.
DIGITAL AND TIMING I/O
Spring Terminal Block

Internal
Connection

PFI 9/P2.1
PFI 8/P2.0
PFI 7/P1.7
PFI 6/P1.6
PFI 5/P1.5
PFI 4/P1.4
PFI 3/P1.3
PFI 2/P1.2
PFI 1/P1.1
D GND
USER 2
PFI 14/P2.6
+5V
+5V
D GND

P0.7
P0.6
P0.5
P0.4
P0.3
P0.2
P0.1
P0.0
PFI 13/P2.5
D GND
USER 1
PFI 11/P2.3
PFI 10/P2.2
AI SENSE
AI GND

USER 1 BNC

Internal
Connection

USER 2 BNC

D GND

Figure 4. USER <1..2> BNC Connections

Figure 5 shows an example of how to use the USER 1 and USER 2 BNCs. To access the PFI 8 signal
from a BNC, connect USER 2 on the spring terminal block to PFI 8/P2.0 with a wire.
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DIGITAL AND TIMING I/O
Spring Terminal Block
PFI 9/P2.1
PFI 8/P2.0
PFI 7/P1.7
PFI 6/P1.6
PFI 5/P1.5
PFI 4/P1.4
PFI 3/P1.3
PFI 2/P1.2
PFI 1/P1.1
D GND
USER 2
PFI 14/P2.6
+5V
+5V
D GND

P0.7
P0.6
P0.5
P0.4
P0.3
P0.2
Wire
P0.1
P0.0
PFI 13/P2.5
D GND
USER 1
PFI 11/P2.3
PFI 10/P2.2
AI SENSE
AI GND
USER 2 BNC

Internal Connection
BNC Cable

D GND

PFI 8
Signal

Figure 5. Connecting PFI 8 to USER 2 BNC

The designated space below each USER <1..2> BNC is for marking or labeling signal names.

Specifications
This section lists the specifications of the BNC-2110. These specifications are typical at 25 °C unless
otherwise specified.
Note

Refer to your DAQ device documentation for specifications about analog input, analog output,
trigger/counter, and digital and timing I/O signals.

Physical
Dimensions ............................................................19.05 cm × 10.48 cm × 3.51 cm
(7.5 in. × 4.125 in. × 1.38 in.)
Weight ....................................................................798 g (1 lb 12.1 oz)
BNC connectors.....................................................15
Spring terminal block.............................................30 positions
Wire gauge .............................................................28–16 AWG wire
I/O connector .........................................................68-pin SCSI male connector

Environment
Operating temperature ...........................................0 to 70 °C
Storage temperature ...............................................–55 to 125 °C
Relative humidity...................................................5 to 90%, noncondensing
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Pollution Degree (indoor use only)........................2
Maximum altitude..................................................2,000 m

Safety
This product is designed to meet the requirements of the following standards of safety for electrical
equipment for measurement, control, and laboratory use:
•

IEC 61010-1, EN 61010-1

•

UL 61010-1, CSA 61010-1
Note For UL and other safety certifications, refer to the product label or visit ni.com/
certification, search by model number or product line, and click the appropriate link in the

Certification column.

Electromagnetic Compatibility
This product is designed to meet the requirements of the following standards of EMC for electrical
equipment for measurement, control, and laboratory use:
•

EN 61326 EMC requirements; Minimum Immunity

•

EN 55011 Emissions; Group 1, Class A

•

CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A
Note

For EMC compliance, operate this device according to product documentation.

CE Compliance
This product meets the essential requirements of applicable European Directives, as amended for
CE marking, as follows:
•

2006/95/EC; Low-Voltage Directive (safety)

•

2004/108/EC; Electromagnetic Compatibility Directive (EMC)
Note

Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory
compliance information. To obtain the DoC for this product, visit ni.com/certification,
search by model number or product line, and click the appropriate link in the Certification column.

Environmental Management
National Instruments is committed to designing and manufacturing products in an environmentally
responsible manner. NI recognizes that eliminating certain hazardous substances from our products is
beneficial not only to the environment but also to NI customers.
For additional environmental information, refer to the NI and the Environment Web page at ni.com/
environment. This page contains the environmental regulations and directives with which NI
complies, as well as other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)
EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling center.

For more information about WEEE recycling centers and National Instruments WEEE initiatives,
visit ni.com/environment/weee.htm.

⬉ᄤֵᙃѻક∵ᶧࠊㅵ⧚ࡲ⊩ ˄Ё RoHS˅
Ёᅶ᠋ National Instruments ヺড়Ё⬉ᄤֵᙃѻકЁ䰤ࠊՓ⫼ᶤѯ᳝ᆇ⠽䋼ᣛҸ (RoHS)Ǆ
݇Ѣ National Instruments Ё RoHS ড়㾘ᗻֵᙃˈ䇋ⱏᔩ ni.com/environment/rohs_chinaǄ
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni.com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents.txt file on your CD, or
ni.com/patents.
© 1998–2007 National Instruments Corporation. All rights reserved.
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